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roject managers who are hungry for resources to help
them do their job more efficiently and effectively have
two new – yet familiar – online entrées from which to

choose. Recently expanded online offerings from MPA (formerly
known as MPUG) and a new Microsoft Web site offer two of the
largest, most diverse collections of online resources for project
managers – regardless of whether they need tips on how to
define the scope of a project, to sign up for an upcoming MPA
chapter meeting or to find a new job. 

The revamped MPA members-only Web site and other new
online services debut this month, while Microsoft Office Online
launched its new Tools for Project Managers Web site last
September. The two offer complementary resources, with the
new MPA offerings building on the free articles, training
materials, templates and animated videos on the Tools for
Project Managers site. 

“The demands on project managers are growing every day,” said
Ashish Chopra, product manager for the Project team at
Microsoft. “To successfully manage the different project
management challenges they face and get the most out of
Microsoft Office Project, they need to be able to easily build their

skills and use Project in the most effective way, access the latest
information and resources, and network and learn from their
peers. Together, these sites offer a wealth of valuable resources
and help build a community of project managers that facilitates
knowledge sharing.”

MPA has spent the winter expanding its online resources to
create a new system of membership benefits on its Web site. You
can check out the enhancements at www.mympa.org.

Figure 1 – The new MPA website at www.mympa.org.

Microsoft sponsored the enhancements and continues to work
with MPA to help create a community of project managers. The
new MPA offerings are based on feedback and surveys of the
association’s members. While grateful for the member-driven
content, face-to-face learning and networking opportunities
MPA has offered for years, members asked for more online
resources, said Christine Buonocore, executive director of MPA.
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“Microsoft recognizes MPA as the leading industry
association helping project managers and organizations
get the maximum value out of Microsoft Office Project.
With its different avenues to interact and network and
resources on Microsoft Office Project, MPA is playing a
pivotal role in helping project managers and organizations
learn from each other and maximize the success of their
projects using Project. We strongly believe that any
individual managing projects would benefit immensely
from being part of this association.”

Michael Angiulo, General Manager
Microsoft® Office Project, Microsoft Corporation

hen I joined the MPUG team
last summer and wrote my
first editor’s article for the

September issue, I stated several lofty goals
for the organization I was striving towards.
I set out to “further the great reputation of
MPUG to a broader base of Project users”
and to “make your experience with MPUG
the best it can be.”

Over the winter the MPUG (now known as MPA) team worked
diligently to make these goals and what some naysayers might even
consider dreams, a reality. In March, MPUG began the official
transition from MPUG-Global to MPA. This name change depicts
what the MPA family feels is a reflection of our community growing
from a user group into a professional association dedicated to
Microsoft Office Project. Our revamped tagline for MPA is the
Official Industry Association for Microsoft Office Project.

Along with a new name, MPA has a new brand identity to help
facilitate this change. The MPA logo reflects core
values of the association. The inner circle represents
the community coming together while the outer
circle reflects the continuous learning and

information sharing, networking, and trading experiences
amongst the members on a global level. The diamond depicts a
milestone, which signifies the achievement of key goals and vital
stages within a project. This encompasses MPA helping
members reach their objectives professionally, whether on the
project, job or in their career. 

MPA has not only experienced a name/brand change, but a
complete overhaul has been made to the web site with new
features added to bring more value to your membership. The
web site has been completely re-designed to improve navigation
and functionality. The new URL you will want to bookmark is
www.mympa.org. The members-only content library now
features enhanced search functionality where members can rate
and post comments on the material.

Members now have your own personalized ‘My MPA’ page that
allows you to maintain your personal data such as contact
information on file with MPA. You also will have the ability to select
the MPA Chapters you want to receive meeting notices about and it
will automatically send notices to you for future events.

On-line event registration is available for all Chapter meetings
throughout the world. This centralized reservation system for
MPA events will create a one-stop-shop so members don’t have
to work separately through their chapters for event registration. 

Another new benefit is the addition of a Job Board that allows
members to post job openings and search for employment.
Employers who are members will have the added convenience
of being able to post and manage their job postings.

A new Members Forum will be featured in the members-only
section when Phase II of the site is rolled out during the summer.
This area will allow members to post questions/comments and have
other members provide feedback. This open exchange of
information and ideas should provide a great resource for the
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Angie Wean, Editor

“Project Mentor is more than a
computer-based tutorial, it is a

business tool and ready
reference for jump-starting our

busy headquarters staff to
develop Microsoft Project and

project management skills as a
core competency.”

Stephen Michaelson, Program
Manager, United Airlines

With a copy of our acclaimed Project Mentor™ you can immediately access computer based training software that 
teaches the entire Microsoft® Office Specialist curriculum for Microsoft Project. This innovative self-paced training tool has
been carefully designed to be challenging and thought-provoking, yet still remain exceptionally simple to use. Flexible and
cost-effective training to help you plan and manage real projects is available on your PC; 24 hours a day, 7 days a week.

Project Learning Limited
Wharfebank Business Centre

Otley, LS21 3JP, UK
+44(1943) 466464

Copyright © 2004 Project Learning Limited. Microsoft
is a registered trademark of Microsoft Corporation.

Try Project Mentor for yourself. Download an
Evaluation Kit from:

www.projectlearning.net/project_mentor_evaluate.htm

MPA Members - Buy Project Mentor online 
and get a 15% discount. Just go to:

www.projectlearning.net/mpa

entire community and enhance the on-line synergy of our
association.

MPA will continue to deliver on the benefits that members have
come to enjoy over the past eight years. This newsletter, the
monthly electronic newsletter emailed directly to you and our
involvement with each Chapter will continue full steam ahead
along with our commitment to the R.E.P program so that
members may earn PDU credits via MPA activities. 

Now to address my remaining goal: to further the great reputation
of MPA to a broader base of Project professionals. MPA has created
a new electronic publication, MPA Ezine for Microsoft® Office
Project, geared towards non-members who want to learn more
about MPA and are evaluating membership. One can sign up for
this publication on the MPA homepage, as well as on Microsoft
Office online. With this electronic publication we hope to increase
our circulation of non-members and turn them into members to
bring even more value, knowledge and a more robust network to
our existing membership. MPA encourages current members to
refer their non-member friends and colleagues to this newsletter to
help spread the word of the benefits of MPA and bring added value.

Member feedback over the years has spawned these new benefits
and made them possible to the entire association. To each of you
who have contributed over the years, the MPA team thanks you for
helping make MPA the leading association for Project professionals.

From the Editor Continued from page two

Continued on page four

“With the support of our co-sponsors, Pcubed and Microsoft, we
have been able to provide our members a higher level of service,
one that brings MPA closer to its ultimate goal of becoming the
definitive resource – online or offline – for any professional who
leverages Microsoft Project,” Buonocore said. 

The new and enhanced membership benefits include:

➣ Searchable Library: Members can not only find what they
are looking for faster with the new searchable library
service; they also can discover resources they may not have
known were available, by performing automated searches of
MPA’s vast online content library, which includes articles,
white papers, case studies, tips and more. In addition, the
library allows members to share knowledge and provide
feedback, as well as rate content. 

➣ Personalization: Members can more easily access the
MPA information most valuable to them – such as details
about upcoming MPA events closest to them – by logging
into their ‘My MPA’ portal page. 

➣ Job Board: Members can browse for jobs or post job
openings on the online job board.   

➣ Easier Event Registration: Members can review information
about upcoming MPA events and chapter meetings, as well as
register to attend directly on the MPA site.  

Microsoft’s Tools for Project Managers Web site provides a

New Online Resources Expand Learning Options
for Project Managers
Continued from page one
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variety of resources, including templates, articles and animated
video demonstrations. The site is part of the new Tools for Your
Job section of Microsoft Office Online, which provides content
aimed at helping people in specific occupations use Microsoft
Office to be more productive. 

The site, www.microsoft.com/occupations/projectmanager (see
Figure 2), is organized according to common project-
management tasks, offering a collection of tools to help project
managers complete each task more productively. Tools for
Project Managers currently provides assistance for 10 tasks.
Among them: defining the scope of a project, estimating the
duration of tasks, identifying and planning for risks and
reporting project performance. Additional resources can be
found on the Project Portal on Office Online at
www.microsoft.com/project.

Microsoft worked with a wide range of project managers to
define the tasks and tools included on the site, said Microsoft
Acquisitions Editor Charlie Montgomery. “Our goal is to help
professionals get the most value from Microsoft Office at work,”
Montgomery said. “Project managers will find really tight
integration between Tools for Project Managers and the
templates and other Microsoft Office Project content.”

The Tools for Project Managers site also includes a Tell Us Your
Story link, where project managers are encouraged to share
stories, tips, and best practices. “We know there are a lot of people
in the Microsoft Office Project community who have knowledge
of best practices that they are willing to share,” Montgomery said.
“This knowledge can help their peers avoid common pitfalls and
work more efficiently and more productively.” 

Figure 2 – The introduction page of the
‘Tools for Project Managers’ Website.

Continued from page three
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he Project/Program Management Office (PMO) is the
fastest growing concept in project management and is
the key to successful implementation of Project

Management within your organization.

PMO is commonly used in IT departments for project portfolio
and resource capacity reporting but is also increasingly used by
companies to deal with their major business initiatives such as
mergers, acquisitions, and organizational realignments.

The purpose of this article is not to teach you how to implement
a PMO as there is a great deal of literature available on this topic;
but rather to share my experience on the key dimensions of
building and developing PMO capability within your
organization.

Establish a scalable PMO

One of the key dimensions of developing PMO capability within
your organization is to establish both the design and the
deployment of your PMO on a scalable model. It will ensure that
your critical needs are always met as the maturity of your
organization evolves.

Your PMO design will be composed of various releases that will
each include a set of processes, procedures, tools and templates.
The first PMO release will cover the governance process, the
critical project management processes, as well as their associated
tools and procedures.

Let’s start with the governance process. You will find that
establishing a solid governance process is extremely time-
consuming because it involves reaching agreement with many
stakeholders in the preliminary stage of the initiative. It involves
defining roles and responsibilities, level of authority of various
stakeholders, project metrics and reports as well as the various
forums, their frequency and attendees.

Secondly, you are likely to find out that each initiative or
organization has different project management drivers. For a
merger or an acquisition, legal deadlines are likely to drive the
initiative, and therefore, your first PMO release will need to
focus primarily on schedule management. On the contrary, for
an IT organization, you will find that time tracking is the most
critical driver. Many IT organizations are investing a great
amount of time and money to implement time tracking
solutions because there is a strong need to increase visibility and
control on where the IT budget is spent. The Gartner group
claims that the ratio between non-project work and project work
should be 20%. You will find that in many IT organizations, this
ratio is reversed. In other words, people are spending most of
their time on non-project work. In this case, your PMO will
need to focus its first release on time-tracking management.

Finally, your first PMO release will need to include the different
tools and procedures associated with your key project
management processes. An effective PMO can be set up without

Pcubed (www.pcubed.com) specializes in EPM, server-
based solutions, software implementation and technical
support. Drawing on vast customer experience and
expertise, Pcubed Perspective provides a blend of
strategic and technical content, with a varied look at how
Microsoft Project is being utilized within the marketplace.

Pcubed Perspective

Key Dimensions of Developing PMO Capability
Blaise Novakovic, PMP, Pcubed (Member, San Fransisco Bay Area Chapter)

T

expensive additional software, although your organization’s
needs may eventually grow to the point where it requires an
enterprise project management suite such as Microsoft Office
Project Server 2003. The strengths of the Microsoft Project
scheduling engine are all well known. In my view, Windows
SharePoint Services provides the biggest “bang for the buck”
because it can be used to enable the promotion and the
evangelization of key project management processes such as
risk, issue and change management processes by providing a
single, simple and highly collaborative portal access to all users.

Learn to love politics

Another key dimension of developing PMO capabilities within
your organization is to acknowledge politics as being the prime
force for moving your organization or initiative.

Many people feel disdain and repugnance towards politics, but
in order for your PMO to be truly successful it is essential to use
politics appropriately and not become its servant. You will find
that the biggest challenge in implementing a PMO is to
overcome the numerous political barriers.

First of all, your PMO has to be incorporated into an existing
structure where roles and responsibilities and levels of authority
are clearly defined. PMO is based on interrelatedness, and its
goal is to increase control, visibility and collaboration by
breaking the barriers between departments. However, power
holders are often department or functional managers that are
more likely to see the implementation of a PMO as a threat and
not as an enabler of their future.

Secondly, you will find that your PMO is likely to operate
outside the standard functional hierarchy and its members do
not have the authority to execute the various project
management processes included in your first PMO release. 

There are different tactics that can be used to overcome this
strong organizational power.

First of all, in the initial stage of your PMO implementation, it is
necessary to do a thorough stakeholder analysis that will allow
you to identify political conflicts that could occur as well as to
propose some positioning tactics to prevent them from
occurring.

Secondly, it is essential that your PMO staff is able to develop
“personal” power in the organization using “human” skills such

Continued on page six
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Key Dimensions of Developing PMO Capability
Continued from page five

Mike Angiulo Supports MPA Chapter!
The MPA San Francisco Bay Area Chapter was honored to have
Mike Angiulo, General Manager of the Microsoft Project
Business Unit, speak at the February meeting. Angiulo is
responsible for the product development and strategic direction
of the Microsoft Project business. Officers and others who
attended said that ‘people need to here what Mike had to say.’
This is consistent feedback from other chapter meetings, and
attests to how valuable direct face-to-face interaction is as a
membership benefit.

as bargaining, influence, conflict management and negotiation.

Finding resources that are able to design a PMO in a scalable
manner as well as to operate your PMO in a highly political
environment might be the biggest challenges of all. That takes us
to the last key dimension for developing PMO capabilities
within your organization, the use of PMO consultants.

Use PMO consultants

Even though PMO consultants cannot be expected to be as
familiar with the organization as the managers, and are generally
more expensive for each day of service than most employees,
they provide, in my biased view, benefits that cannot be ignored.

First of all, organizations sometimes find themselves short of
PMO expertise. Engaging project management consultants will
allow you to get started on both your PMO design and operation
by bringing the best practices and real life experiences within
your organization. 

Also, because consultants have apolitical viewpoints and are
power agnostic, their views and opinions are more likely to be
accepted as unbiased.

Finally, consultants can evolve within the organization more
easily; they generally have access to C-level sponsors and can
truly act as change catalysts for your organization.

Last but not least, in the event your PMO implementation fails,
you can always blame the consultants!

MPA San Francisco Bay Area Chapter Officers – From left to right:
David Brown, Roger Warren, Phil Novak, James Nuthall, Dinesh Mistry,
Ray Sanchez-Pescador, Joe Bellows, Mike Angiulo (Microsoft®), Peg Robinson.

Mike Angiulo, the Microsoft Office
Project General Manager, talked
with MPA members in San
Francisco in February 2005 about
Project, and how the Microsoft
Office Project team is listening and
responding to customers needs.
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Ask Brian

instead of durations? MS Project does not have built in
functionality for supporting this kind of “Work PERT”
estimating. But one of the cool things about Project is that with
a little work in VBA (Visual Basic for Applications) you can make
it do almost anything. A very short VBA routine can give us this
functionality. It uses 6 custom number fields (Number1 –
Number6) and a custom Text field (Text1). The fields should be
as follows:

You can choose to enter these in an existing view or create a new
one for them. You can arrange them as you like but remember
which weight goes with which estimate.

One of the advantages of this tool is that you can have different
weights for each task. In the normal PERT tool in Project you
had to pick one set of weights for the entire plan. But sometimes
you might have different levels of confidence in the estimates for
different tasks. With the “Work PERT” tool you can set weights
on a task by task basis.

Once you have the weights set and the estimates entered you
just have to run the macro shown in Figure 2. It will only run
for tasks that are unstarted and for each task it runs through it
will place a status in the Text1 field. For completed or in
progress tasks it will enter “Not Calc’d: Task In Progress or
Complete”. For tasks where the Work value is calculated it will
enter the date the value was set.

In the event that the weights do not equal 6 it will put a message
in the Text1 field stating that there was a problem with the
weights. If you see this note you should fix the weights and run
the macro again.

Ask Brian covers topics appearing in the Microsoft Office
Project Support Newsgroup, where people with questions about
Microsoft Office Project can interact and seek solutions.
Members can find this newsgroup and many more in the
Members Only Section, www.mympa.org/members.asp

Continued on page eight

hree point estimating can help project managers make
better estimates because it gives them more granular
control of how the end value is calculated. Rather than

just being a number that gets entered it is the weighted average of
the three estimates. For most of us our exposure to three-point
estimating has been PERT (Program, Evaluation and Review
Technique). PERT is three-point estimating for Duration values.
Microsoft Project gives us access to PERT estimating via the
Analysis toolbar. But what if you want to do three-point
estimating for Work? PERT in Project does not allow for this kind
of estimating for work values. This article will cover the basics of
three-point estimating and also provide a VBA routine that will
allow you to use custom fields to generate work estimates from a
three element estimate set.

What the Heck is PERT and for that Matter, What the
Heck are Three-Point Estimates All About?

For those that have not heard of PERT it is a technique of using
three different estimates to derive the duration of a task. The
values are Optimistic, Pessimistic and Most Likely. PERT asks a
project manager to give each of these estimates a weight. You can
think of the weight as a measure of confidence in that estimate. 

Figure 1 – This view shows how three different estimates derive the
duration of a task.

Figure 1 shows that there are three estimates and for each there
is a weight. The weights must equal 6. This particular weighting
shows one of the advantages of three-point estimates. This
project manager has decided to compensate for some uncertainty
or risk in the estimates by giving no weight to the Optimistic
estimate and equal weight to the Most Likely and Pessimistic
values. This will make the value in this case be the average of the
Most Likely and Pessimistic values. An even more pessimistic
path would be to give the Most Likely value a weight of 1 or 2
and the Pessimistic value a weight of 4 or 5. Using the weights
the PM can have more control over how the estimates are used to
get the value. A very confident estimate might have a weight of 5
on the Optimistic and 1 on Most Likely. This might be a good
choice for an estimate of a task that has been done several times
before and always taken the same time to complete.

The basic formula for such a weighted average is as follows:

((Opp * Opp Weight) + (Pess * Pess Weight) + (ML * ML
Weight)) / 6

The VBA Routine

Now you can see the benefits of using three-point estimates in
your scheduling. But what if you tend to estimate work values

Custom Field

Number1

Number2

Number3

Number4

Number5

Number6

Text1

Field Title

Opp. Work

ML Work

Pess. Work

Opp. Weight

ML Weight

Pess. Weight

Work PERT Status

Three Point Estimating for Work Values
Brian Kennemer, Microsoft Office Project MVP, Quantum PM (Member, Puget Sound Chapter)

T
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Sub WorkPERT()
Dim tskT As Task
Dim blnFoundBadWeights As Boolean

blnFoundBadWeights = False

For Each tskT In ActiveProject.Tasks
If Not (tskT Is Nothing) Then

If tskT.PercentComplete = 0 And tskT.PercentWorkComplete = 0 Then
If (tskT.Number4 + tskT.Number5 + tskT.Number6) = 6 Then

tskT.Work = (((tskT.Number1 * tskT.Number4) _
+ (tskT.Number2 * tskT.Number5) _
+ (tskT.Number3 * tskT.Number6)) / 6) * 60

tskT.Text1 = "Work Calc'd: " & Now()
Else

tskT.Text1 = "Not Calc'd: Weights <> 6"
tskT.Work = 0
blnFoundBadWeights = True

End If
Else

tskT.Text1 = "Not Calc'd: Task In Progress or Complete"
End If

End If
Next tskT
If blnFoundBadWeights = True Then

MsgBox Prompt:="Some Tasks Weight Values were found to be incorrect." & _
Chr(13) & "Check the Text1 fields for details.", Buttons:=vbCritical, _
Title:="WorkPERT Weights Error"

End If
End Sub

Figure 2 – This macro will provide estimated work values instead of durations.
©TechRepublic 2005. Reprinted with permission from TechRepublic.

Ask Brian Continued from page seven

Customer Question:
I have an issue with data copied and Pasted Special (with
links). My objective is to create a single row in Project
showing information from several predetermined tasks in
the plan, and to bring these rows together in a single
portfolio view. How do I do this?

MPA Answer:
To create the single row, first create custom fields, then copy
the cell from the row, and select Pasted Special and then
Paste Link to the receiving cell. In order to make sure the
links are not lost and the receiving cells are blank when
inserting these plans into the master, you must copy the
row from the source plan, and paste it into the master plan.
It's best then to delete all other rows from the copied plan
for simplicity. (See sample outcome below.)

MPA Tip File
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xperienced schedulers build their schedules carefully,
using dependencies, calendars, and other tools to build
a model of their project. They avoid fixing tasks to

dates, because dates always change.

What do you do, though, when resource-leveling and other
issues demand that a particular task start just a few days or
weeks later? How do you model these situations so that your
schedule will handle change gracefully? The easiest approach is
to overtype the start or end date, creating a constraint, but a
more effective method is to use delays.

Microsoft Project offers three types of delays, allowing a project
manager to model almost any project accurately. Many project
schedules require just one or two of these delays, but learning
all three ensures that you can select the correct tool in any
situation. The three types of delays are:

• Task-level leveling delay 

• Assignment-level leveling delay 

• Assignment delay 

This article assumes experience creating basic predecessor and
successor relationships between tasks in a Microsoft Project
schedule. Examples focus on the common finish-to-start
relationships. Experiment before using other types (FF, SS, SF).

All these delays build on top of the basic dependencies with
leads and lags. Let’s review the use of leads and lags.

Leads and Lags

Predecessors usually appear as a task number or a list of task
numbers. It is possible to adjust the task relationships by entering
a lead or lag time. For instance, a predecessor of “3FS+2d” means
that the task will start two days after task #3 finishes. Lags are
represented by positive numbers and leads by negative numbers.
You can enter these adjustments right into the predecessor or
successor column of a task list, or in the “Lag” column of the Task
Information dialog box or the Task Form window.

You can enter a lead or lag in any unit of duration, including
weeks, days, hours, or minutes. Using leads or lags, a project
manager can make just about any date adjustment. With this
one tool, you can completely eliminate the use of fixed-date
constraints in a schedule. Unlike fixed-date constraints, leads
and lags will make all the dependent tasks move together when
a predecessor’s date changes.

So Why Use Delays At All?

If leads and lags can do the whole job, why even use delays?
Why worry about mastering three different types of delays?

Leads and lags are designed to represent inflexible constraints
on your schedule. For instance, if walls cannot be erected until
at least three days after the concrete foundation is poured, that
is typically entered as a finish-to-start predecessor with a three-
day lag. This waiting period is part of the sequencing logic of the
schedule.

Delays (the good kind...)
Alex S. Brown, PMP, Mitsui Sumitomo Insurance Group (Member, Philadelphia-Delaware Valley Chapter)

Continued on page ten

E Delays are designed to represent constraints that are not part of
the strict sequencing rules for the project. Resource leveling is
the most common application for delays. If you want, you could
use leads and lags to do resource leveling, but how would you
know if a particular lead or lag was introduced as part of the
project's sequencing rules or because of a resource conflict?
Using separate fields for delays makes the difference clear.

Using Leveling Delays

If you have ever used the automated Resource Leveling features
of Microsoft Project, you may have wondered, “How does it
make my tasks jump around that way? It is not fixing the start
or end dates, so why are the dates moving around?” The leveling
delay fields are the secret. You can change them by hand, either
instead of or in addition to automated Resource Leveling.

The easiest way to see them is to use the built-in Leveling Gantt
view. Go to the View menu, select “More Views...” and pick
“Leveling Gantt” from the list. The column “Leveling Delay”
appears as the second column. Of course, you can also add this
column to your favorite view if you prefer, but this view is pre-
configured with useful information for resource leveling. 

Task leveling delay is an unusual duration field. It must be
entered in elapsed duration units. “Elapsed” means that it is
calendar or clock time, not work time. Put an “e” in front of the
unit to enter an elapsed duration. For instance “ed” represents
elapsed days. Three elapsed days starting on a Friday will end
on Monday even if the weekends are non-working days. You can
actually enter elapsed days in many duration fields. Task
leveling delay is unusual because it requires elapsed duration.

If you have used Resource Leveling in Microsoft Project, there
may already be values in the fields. If not, they will start as zero.
As you enter values into the fields, the start date for the
matching task will move further into the future. By fine-tuning
these values you can resolve resource conflicts and over
allocations.

Assignment Leveling Delay

The Task Leveling Delay field moves the entire task in time.
What if you want to delay the start date for just one resource
assigned to a task? The Assignment Leveling Delay field allows
you to delay each assignment individually.

You can add this column to any assignment-level view, but the
simplest way to display it is to use the Task Entry view. This view
features a split screen with a Task Form in the bottom pane to
enter details about the task selected up top. (See Figure 3.) Click
on the Task Form in the lower pane to select it, then go to the
Format...Details... menu and select the “Resource Schedule”
format. Each assignment will show a value in the Leveling Delay
column. This delay is entered in standard duration units, not
elapsed units.

Entering a number in this column will delay the start of that
particular assignment. The start date for the task remains
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Delays (the good kind...)
Continued from page nine

unchanged, but the finish date may move as you change the delay.

Using both assignment and task leveling delays can lead to
confusing situations, where it is hard to tell why a task has a
particular start or end date. I tend to avoid assignment delays
and instead create multiple tasks, one for each resource. I find
that this treatment makes the schedule easier to read and track.
Each resource gets their own start and end date clearly marked
at the task level. Of course, it is good to have the flexibility to
delay an individual assignment when you need it.

Assignment Delay

Microsoft Project provides a third delay field, called assignment
delay. It is a different field from the assignment leveling delay,
but it works exactly the same. Enter a duration into the
assignment delay and the resource will begin work that number
of hours, days, or weeks after the task start date. Enter a value
for both assignment delay and assignment leveling delay and the
total delay will be the total of the sum of the two delays.

The assignment delay field is available in the “Resource
Schedule” Task Form discussed above. It is labeled “Delay” in
that view. You can add the value to any assignment-level table by
adding the “Assignment Delay” field to the table.

Use of Leveling Delays vs. Other Delays

People sometimes ask why there are separate leveling delays at a
task and assignment level. After all, they just add to the effects
of task-level lags and assignment-level delays.

These dedicated leveling-delay fields are devoted to the issue of
resource leveling. Under the Tools menu, the Level Resources...
menu item displays the Resource Leveling dialog box. (See
Figure 4.) This screen allows the scheduler to re-level resources
automatically. The “Clear Leveling...” button, resets all the
leveling delays to zero. “Level Now” automatically adds leveling
delays to the tasks of the project to attempt to level the
resources. The “leveling can adjust individual assignments”
checkbox determines whether or not this leveling engine will
use the assignment leveling delay.

Figure 4 – The Resource Leveling dialog box lets you automatically
adjust leveling delays for the whole schedule.

Figure 2 – Both tasks have the same predecessor but one starts later because of leveling delay

Figure 1 – Two tasks with a two-day lag between them

Figure 3 – One task with two resources assigned. One assignment has a two-day leveling delay, turning a
five-day task into a seven-day task.

Continued on page eleven
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The assignment delay field is never changed by this dialog box,
and neither is the task-level lead or lag. A scheduler can use
these two fields for scheduling constraints that exist regardless
of resource availability and the leveling delays to represent
scheduling constraints that are based on resource constraints.

Putting It All Together

These techniques will help you build a more robust schedule.
They help you apply change to just one part of a schedule and
have the changing dates ripple through the rest of the schedule
more consistently.

For instance, imagine creating a schedule for a deliverable with
four one-week tasks. They could be done in any order, so you
enter them with no dependencies and use fixed dates to allow
one person to accomplish them over a period of four weeks. If
the resource actually starts doing the work out of order or delays
start on the work, the dates for each task must be updated
manually. Building a predecessor chain for the tasks would help
with rescheduling remaining work, but would require a lot of
rework if the resource does the work out of order.

Using delays, though, you can schedule these four tasks with a
single start milestone as a predecessor and a single finish
milestone as a successor. Enter appropriate leveling delays for
each task to level out the resource use. Now if the work is

Continued from page ten

rescheduled, you can simply move the start milestone's date and
the rest of the tasks will follow, keeping the previous leveling
delays intact. In most situations, these tasks will remain resource-
leveled after changing the one milestone. If the resource does the
work out of order, you can adjust the leveling delays as needed.
Because your predecessor and successor values only show real
dependencies, you do not need to change them. Adjusting
leveling delays, you can be confident that your project's
sequencing rules are still enforced.

The Good Kind of Delays

The word “delay” usually causes stress for project managers,
giving them visions of overrun budgets, late delivery, and lots of
overtime. In Microsoft Project, though, delays are a critical
scheduling tool. By using Leads and Lags, Leveling Delays (task
and assignment), and Assignment Delays a project manager can
accurately represent the most complex schedules. Schedules
built using these delays will be much more resilient than ones
built using fixed-dates constraints. Tasks will move together
according to the rules set by their constraints and their delays,
instead of being fixed to a particular date.

Alex S. Brown, PMP provides advice to peers internationally through
his web site, http://www.alexsbrown.com. All material © 2005 Alex S.
Brown. All rights reserved. 

MPA Welcomes
Sacramento Valley Chapter!

m p a

TM

The newly formed MPA Sacramento Valley Chapter Officers were on hand at
launch night, as were two keynote speakers, Eric Uyttewaal (IIL) and Mike
Angiulo (Microsoft). Back Row left to right:  Dohn Kissinger, Rich Newbold,
John Semko, Eric Uyttewaal, Mark Dochtermann—Front Row left to right: Dee
Smith, Lance Williams, Chad Hodges, Patti Rabe, Mike Angiulo, Derek Loar

Eric Uyttewaal, PMP Executive Director, Microsoft EPM Division,
International Institute for Learning, Inc. is caught in the moment
delivering a key message during his presentation titled Microsoft Project
Best Practices. Author of the “Dynamic Scheduling with Microsoft
Project” series, Eric delivers an energized presentation.

The Sacramento Microsoft Office was at maximum capacity of 60 people who
attended the MPA Sacramento Valley Chapter launch in February 2005. The
Chapter officers received rave reviews from those who attended, citing that
the event was exciting, well executed, and packed with information that
could be directly applied to Microsoft Project situations the next day.  
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uantitative Risk Analysis has become an important component of project management. According to Guide to the Project
Management Body of Knowledge (PMBOK ® Guide, Third edition 2004, Project Management Institute) “Quantitative Risk
Analysis is performed on risks that have been prioritized by the Qualitative Risk Analysis process as potentially and
substantially impacting project’s completing demands. The Quantitative Risk Analysis process analyzes the effect of those risk

events and assigns a numerical rating to those risks.” 

Microsoft Project implements Qualitative Risk Analysis methodology, but what about quantitative analysis? Quantitative Risk Analysis
gives the project manager ability to see how the project schedule will be affected if certain risks occur. As a result, project managers are
able to mitigate risk factors and manage their projects better.

PERT Analysis in Microsoft Project

Microsoft Project implements the Quantitative Risk Analysis technique PERT (Program Evaluation and Review Technique). The PERT
model was developed in the 1950s to address uncertainty in the estimation of project parameters. According to classic PERT, expected
task duration is calculated as the weighted average of the most optimistic, the most pessimistic, and the most likely time estimates. The
expected duration of any path on the precedence network can be found by summing up the expected durations. 

Using PERT in Microsoft Project is very easy using the PERT toolbar. To enable the PERT toolbar on the View menu, from the Toolbars
menu, choose PERT Analysis (see Figure 1).

Continued on page thirteen

Quantitative Risk Analysis with Microsoft Project
Lev Virine, Ph.D., Intaver Institute Inc. (Member, Calgary, Alberta)

Q

Microsoft Project has four views that help you to enter data for
PERT analysis: separate views for optimistic, expected, and
pessimistic duration, as well as a PERT entry sheet. The most
powerful view is the last one, as it allows the user to enter and
see all durations together. After you enter project data, press the
Calculate PERT button on the toolbar. Calculations are
performed based on optimistic, expected, and pessimistic
durations. You will see results of the calculation in the Gantt
Chart view. 

The classic PERT methodology has a number of limitations. The
main problem is associated with accurately estimating the
optimistic, most likely, and pessimistic durations of the task.
Another problem with classic PERT is that it gives accurate results
only if there is a single dominant path through a precedence
network. If there are a number of parallel paths through the
network it gives an overly optimistic estimation. We recommend
using the classical PERT model for quantitative risk analysis if you
have accurate estimations for optimistic, most likely and
pessimistic durations based on reliable historical data and if your
project has a single dominant path through the network.

Figure 1 – PERT Analysis toolbar in Microsoft Project.

Monte Carlo Simulation Models

To overcome the challenges associated with the PERT method,
Monte Carlo simulations can be used as an alternative. Monte
Carlo is a mathematical method used on risk analysis in many
areas and is used to approximate the distribution of potential
results based on probabilistic inputs. Each simulation is
generated by randomly pulling a sample value for each input
variable from its defined probability distribution like uniform,
normal, lognormal, triangular, and beta. These input sample
values are then used to calculate the results such as total project
duration, total project cost, and project finish time. The inputs
can be task duration, cost, start and finish time. This procedure
is then repeated until the probability distributions are sufficiently
well represented to achieve the desired level of accuracy. They are
used to calculate the critical path, slack values, and more. Monte
Carlo simulations have been proven an effective methodology for
the analysis of project schedule with uncertainties.

To use Monte Carlo simulations with Microsoft Project you need
to have an add-on tool. There are a number of such tools
available on the market including @RISK for Project from
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Continued from page twelve

Continued on page fourteen

Palisade Corporation (www.palisade.com), RiskyProject from
Intaver Institute (www.intaver.com), Pertmaster software from
Pertmaster Limited (www.pertmaster.com), Risk+ from S/C
Solutions Inc. (www.cs-solutions.com). These software tools will
help you find answer on the questions such as:

– What is the chance of your project being completed on
schedule and within budget?

– What is the chance that the particular task will be on the
critical path?

– What tasks affect the project duration at most?

– What is the project success rate?

Each Monte Simulation tool has its own specific functionalities;
however, some features are common for all of them. First, all of
the software allows the user to: assign different statistical
distributions including custom distributions to project inputs
(task duration, cost, etc.), perform Monte Carlo simulation, and
output results in different formats. For example, you can use a
frequency or cumulative probability charts or histograms to see
the chance that the project will be completed within a given
period of time (see Figure 2). You can calculate the criticality
index or probability that a task lies on the critical tasks. Figure 2 – Frequency chart can be used to assess the chance that project

will be completed within a given period of time.
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Quantitative Risk Analysis with Microsoft Project
Continued from page thirteen

You can perform a sensitivity analysis or calculate how sensitive the project outputs  (project duration, cost, risks, finish times, etc.)
are to the uncertainties of the project inputs (task duration, finish time, etc.). Results of sensitivity analysis can be shown on a chart,
as in Figure 3. The tasks which are listed highest on the chart have the potential to affect project duration the most.

Figure 3 – Results of sensitivity analysis.

Monte Carlo simulation tools may offer features such as
probabilistic or conditional branching. An example of
probabilistic branching is when the user defines that there is a
40% chance that task A will be successor of task B and a 60%
chance that task C will be successor of task B. An example of
conditional branching is when the user defines that task A task
will be followed by task B if task A duration is greater or less
then a certain value. 

The classic Monte Carlo simulation method has a number of
limitations. Statistical distributions of project inputs such as task
durations should be obtained based on reliable historical data
and in many cases this data is available.  For example, a project
manager usually knows that a particular construction job will
take between 1 and 3 days and can be defined by normal
distribution. However, in some cases, especially for research and
development projects, this information is not available and
using Monte Carlo simulation may not improve your
estimations. It is also very important to constantly track your
project performance and update input data and associated
distributions using performance measurement data. Another
problem associated with Monte Carlo simulations is that if a

project slips, project managers usually perform certain actions.
It is difficult to define and forecast the management response
within a Monte Carlo simulation method.

To overcome these and other challenges Event Chain
Methodology has been developed as an extension of the classic
Monte Carlo simulation method. Project uncertainties can be
defined as a set of risks or probabilistic events (risk lists), which
can be assigned to tasks, resources, or project schedule. Such
events can occur at the middle of the task and can lead to task
delay, restart, and cancellation. Events can cause other events
and generate event chains. Project managers can monitor these
events, determine the critical risks – which affect project
schedules the most – and mitigate them. Event Chain
Methodology allows you to perform Quantitative Risk Analysis
by combining project schedule and risk lists.

You do not need to be a statistician to use Monte Carlo
simulation tools with Microsoft Project. They are designed for
project managers who want to bring the power of Quantitative
Risk Analysis to the project. Project managers have successfully
used such tools in different industries for years.

MPA makes a statistical impact in 2004 thanks to members!m p a

TM

◆ MPA executed 150 events around the world in 2004. This
translated into approximately 300 hours of content for our
members to access on the Members-Only section of the Web site!

◆ Dedicated MPA Chapters worldwide were fortunate enough
to have 300 volunteers serve as Chapter Officers. These
dedicated individuals executed two events per week for 52
weeks, in addition to all of their other Chapter-related
responsibilities!

◆ MPA’s Project Ezine was a great resource of information for
members in 2004. Members were provided 24 Project tips,
informed about more than 75 Microsoft Web casts that
pertained to Project and project management, as well as
received at least one Project update or toolkit each month!

◆ MPA’s quarterly newsletter, The Project Network, featured
28 Project related articles by more than 20 MPA members
who volunteered their time and energy to make this
newsletter a success!
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am used to preparing resource planning reports for our
management team meetings only one hour in advance.
Fortunately, it is very quick and easy to prepare such

reports using the OLAP Cube. Reports can easily be customized
for specific needs and data can easily be manipulated off-line. 

Figure 1 is an example of reports I have prepared:

Figure 1 – A sample report.

The solid line is the organization's total work capacity. Capacity
fluctuates according to the resources'  Max Units, statutory
holidays, and vacations. The stacked area displays the contribution
(i.e., demand on the line org) of each project or group of projects
over time. The dotted line (vertical) is the date that the report was
run. To the left of the dotted line are actual hours spent, and to the
right of it represents remaining/planned work.

In order to try this you will need the name of the server where
your OLAP Cube resides. It is assumed that the OLAP feature is
enabled in your Microsoft Project server environment and that
you have been granted the permissions to access the server.  If
so, follow the steps below to acquire the OLAP Cube data within
Microsoft Excel:

1. Install the required Excel add-ins.

- Starting from a blank Excel sheet:
- Select Tools > Add-Ins...

The add-ins that should be installed are as follows (ensure that
there is a check mark next to each one in the list below), then
click OK.

Access Links
Analysis ToolPak
Analysis ToolPak - VBA
Conditional Sum Wizard
Internet Assistant VBA
Lookup Wizard
MS Query Add-in
ODBC Add-in
Report Manager
Solver Add-in
Template Wizard with Data Tracking
Update Add-in Links

2. Configuring the OLAP Cube connection

- In the blank Excel sheet, select “Data/PivotTable and
PivotChart Report”. This starts the “Data/PivotTable and
PivotChart Report” Wizard, which will remain open until the
following steps have been completed.

How to Run OLAP Cube Query with Excel
Jacques Boulet, PMP, Ericsson, Canada, Inc. (Member, Montreal Chapter)

I - Select “External data source” and click on Next >
- Click on “Get Data...”

- Select the “OLAP Cubes” tab and click OK

- Enter a name of your choice for the OLAP Cube (e.g., “MSP
OLAP Cube”)

- Select the OLAP provider for the database: Microsoft OLE
DB Provider for OLAP Services 8.0

- Click on Connect

- Select “Analysis Server”
- Enter the name of the server where your OLAP cube resides
- Click on Next >

- Select the database and click on Finish

- Select the Cube that contains the data you want to retrieve
and click on OK

- Select the name OLAP Cube you created (e.g., “MSP OLAP
Cube”) and then select OK. This will cause the Microsoft Query
window to open

- Click on Next > on in the “Data/PivotTable and PivotChart
Report” Wizard window

- Click on Layout...

You should now see a blank pivot table with several field
buttons on the right. 

3. Define the pivot table you want by dragging the field buttons
to the pivot table desired column, row, or area. To prepare
resource planning reports, you will need to define two pivot
tables: one for Availability (see Figure 2), and one for Work. Use
field Resource RBS, you will be able to drill-down to lower levels
in the organization if required. You can define pivot tables in
separated worksheets; it will be easier to maintain. When done
placing the field buttons, click on OK, and then press Finish. At
this point, copying the Microsoft Project OLAP Cube data will
generate the pivot table.

Figure 2 – How the layout will appear.

You will now be able to filter and/or drill down into the data
stored in the Microsoft Project OLAP cube within the pivot table
in Excel and prepare chart as usual.

4. All that remains is to Save your Excel file for later use.  When
you revisit this file, make sure you have updated all pivot tables
to ensure you have the latest MS Project OLAP Cube data. Open
the file and click on Data > Refresh Data.

I hope you will enjoy running OLAP Cube query like I do every day.

Author Jacques Boulet would like to thank his colleague
Spiro Theopoulos for his help on this article.
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